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|l. But de ce document

Vous pensez savoir utiliser LibreOffice (ou Word®) car c’est facile et qu’apprendre a 1’utiliser ne
sert a rien ? Ce n’est pas mon expérience. Elle prouve au contraire que la plupart des utilisateurs
n’utilisent pas cet outil comme il faut, alors qu’il est trés facile de gagner en efficacité avec
quelques notions de bases.

En effet, lors de 1’utilisation d’outils comme celui-ci (qualifiés de WYSIWYG') la tentation de
mélanger contenu et forme est tres vive. Par exemple, lorsque vous écrivez un titre, élément de
structure, vous le mettez immédiatement en gros et en gras (forme). Ce faisant, votre document
n’est pas structuré pour 1’ordinateur.

Un autre exemple : vous serez amené a rédiger des rapports parfois trés longs. Eh bien un document
réalisé avec quelques fonctionnalités tres basiques peut vous étre extrémement utile : changer tous
les titres en 2-3 clics, faire un sommaire automatique avec renvoi, les titres qui se numérotent
automatiquement...

Pour la rédaction de longs rapports scientifiques contenant plein de formules et plein d’autres
choses, vous pouvez également vous tourner vers LaTeX. Ce logiciel est congu pour I’édition de
formules mathématiques et propose un rendu tres professionnel pour celles-ci ainsi que des
symboles mathématiques tres peu courants. Il propose également des outils tres puissants pour la
bibliographie®. En outre, il vous force a structurer votre document.

Ce document ne couvre que les fonctionnalités basiques (mais qui vous éviterons de nombreuses
frustrations par la suite). Un autre document couvre des fonctionnalités plus avancées. Vous
trouverez plus d’informations en fin de document. Tout ce que vous lirez est valable pour
LibreOffice 3.6.x et 4.0.x.

Il. Mais pourquoi LibreOffice Writer et pas...

1 Word

Word est un autre logiciel de traitement de texte édité par Microsoft. Pendant longtemps il a fait la
promotion de son propre format qui fonctionne trés difficilement avec les outils concurrents. Le
support de I’OpenDocument (qui est un standard) est beaucoup plus récent. En outre, ce logiciel
n’est ni multiplateforme (comment on le fait marcher sous Linux ?), ni gratuit. Vous pouvez vous
procurer LibreOffice librement et le distribuer a vos amis sans probléme.

2 OpenOffice.org

LibreOffice est en fait le descendant d’OpenOffice.org et est basé sur le code d’OpenOffice.org.
Vous trouverez plus de précision sur Internet.

3 Google Documents et affilié

Bien que Google Documents puisse étre utile pour le travail collaboratif, il est toujours tres loin
d’étre complet. Je dirais méme qu’il lui manque de nombreuses fonctions essentielles présentées
dans ce document. De plus, vous perdez le controle sur vos données et vous étes tributaires de
Google (et de votre connexion a Internet).

1 What You See is What You Get, ce que vous voyez est ce que vous obtenez. A opposer 8 WYSIWYM — What You
See Is What You Mean, ce que vous voyez est ce que vous pensez.
2 LibreOffice propose également de tels outils. Se reporter a la partie avancée.
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1 Structurer un document

Structurer votre document c’est ce qui vous permet de faire la différence entre les titres, le corps de
texte... Vous allez me dire en sélectionnant du texte et en le mettant en gras et en gros, j’ai fait un
titre. Eh bien non. Vous avez structuré le document pour I’impression, pas pour I’édition
informatique. L’idée de la structure c’est de « dire » a votre ordinateur que ce texte sélectionné est
un titre. Il pourra alors le manipuler comme tel et le mettre dans un sommaire, vous proposer des
options de navigation entre vos titres...

1.1 Les titres

Comment faire un vrai titre me direz-vous. Rien de plus simple. Cliquez sur la fleche a droite de
Corps de texte, puis sélectionnez Titre principal. Si ce titre n’apparait pas dans la liste, sélectionnez
Corps de texte et tapez Titre principal.

-8 H 0 HRNSRIY S - "

| |_,| Corps de texte v Liberation Serif v 12 y &8 4 %

NB : le Titre principal est suivi du style Sous titre.

Voila, vous venez de donner un titre a votre document. Vous pouvez également mettre un titre a vos
sections/chapitres en sélectionnant Titre 1 pour le premier niveau puis Titre 2 pour le second niveau
et ainsi de suite.

Titre est une sorte de super-titre. En le modifiant, vous appliquez des modifications a tous les
titres !

Et maintenant, modifions tous nos titres sans en oublier un ! Cliquez sur Styles et formatage en haut
a gauche de I’écran.

H-8lE0HENSRRIYRE - "

m Corps de texte v Liberation Serif v 12 v 8 4 %

Puis faites un clic droit sur 1’élément que vous voulez modifier et cliquez sur modifier (ici Titre
principal).

Vous pouvez alors choisir en navigant dans les différents onglets 1’alignement du texte (centré,
justifié, aligné a droite, aligné a gauche), la police, la taille, la fonte, la couleur... Une fois que les
réglages vous conviennent, appuyez sur OK pour les appliquer. Voila, plus besoin de parcourir tout
le document pour changer les titres. De plus, un titre suivit par un texte ne sera jamais seul sur une

page.
Vous pouvez également ajouter vos propres styles en faisant un clic droit dans cette fenétre et en
choisissant Nouveau.

Ne modifiez jamais au grand jamais I’apparence des éléments de structure via la barre de
formatage. Vous encourrez des problémes a traiter a la main.

Vous pouvez naviguer entre vos titres via le menu de navigation. Pour cela, allez dans Affichage >
Navigateur ou appuyez sur F5. Vous pouvez aussi naviguer entre vos images, index...



1.2 Numeéroter ses titres

Un autre intérét a faire des titres de section c’est que LibreOffice peut gérer leur numérotation tout
seul. Et si vous ajoutez un titre entre deux autres, ils seront renumeérotés automatiquement !
Comment fait-on ? Allez dans la barre d’outils, sélectionnez Outils > Numérotation des chapitres.

Dans la fenétre qui s’ouvre, sélectionnez le type de numéro que vous voulez pour chaque hauteur de
titre. Le champ dfficher les niveaux permet de faire des plans de ce type 1., 1.1,... Appuyez sur OK
pour valider les changements. Vos titres se numérotent sans votre aide !

Numérotation des chapitres
- 1
Mumérotation|Paosition
Miveau MNumérotation
Style de paragraphe 1 Titre 1
2 .
3 Titre 1 v 1.1 Titre 2
: OEEWSN - [111Tive3
1,2 3, .. 4
© Style de caractére
7 a b .. 5
8 Afficher les niveaux TR 6
K i, i, ii
Séparateur e
. i A, . AA . AAA .. 1
) Devant a, .. aa, ., aaa, .. 8
Derriére Titre 9
Titre 10
Commencer a 1 -
DK Format Annuler Aide Reéinitialiser

Les champs Devant et Derriére vous permettent d’ajouter ce que vous voulez avant et apres vos
numéros de titres. Si vous voulez entourer les numéros de vos titres par Salut et Adieu, c’est ici que
ca ce passe. Je vous conseille de mettre un espace dans Derriere (vous comprendrez en lisant la
section sur le sommaire automatique).

2 Insérer des images

Vous pouvez insérer des images a partir d’un fichier via le menu Insertion > Image > A partir d’un
fichier.

Lorsque vous sélectionnez cette image, vous pouvez choisir I’adaptation de cette image. Des
options supplémentaires sont disponibles sous I’onglet Adaptation du texte. Fiez-vous au dessin, ils
sont tres parlants. Vous pouvez également modifier le style Images via Styles et formatage. Ce



faisant, vous pouvez mettre toutes vos images avec la méme adaptation.

En double cliquant sur une image, une boite de dialogue s’ouvre. Elle vous permet notamment de
rogner I’image, de choisir la bordure et la couleur de fond.

Dans I’onglet Type de la boite de dialogue vous pouvez choisir I’ancrage de votre image. Vous avez
quatre types d’ancrage possible : a la page, au paragraphe, au caractere et comme caractere. Cela
vous permet de savoir par rapport a quoi le positionnement de I’image sera fait. Par exemple, si
I’image est ancrée a la page et que vous sélectionnez un positionnement vertical Haut et horizontal
Centré, votre image sera toujours en haut de la page et centrée horizontalement.

Le gros avantage de I’ancrage comme caractere est que I’image se comportera comme un caractere
et restera donc la ou vous 1’avez placé.

r

Image

=1
Type Options|Adaptation du texte Hyperlien|Image |[Rogner Bordures Arriére-plan Macro

Taille Ancrer
Largeur 17,00cm | ® Alapage L]
Relatif Au paragraphe
Hauteur 14,13cm | . Au caractére
Relatif Comme caractére

Conserver le ratio

Taille d'origine

Position

Horizontal Centre v 0. 00cm pour  Page entiére o3

| .

En vis-3-vis sur les pages paires

s

Vertical Haut =

Respecter les enchainements

Ok Annuler Aide Réinitialiser

Afin de réduire la taille de votre document, je vous invite a rogner vos images en dehors de
LibreOffice avec un logiciel de manipulation d’images tel que Gimp. En effet, lorsque vous rognez
une image, LibreOffice conserve I’image de départ dans le fichier. Ainsi, votre fichier odt va grossir
trés rapidement avec des informations inutiles. Il en est de méme pour le pdf généré a partir de ce
fichier.

Si vous rognez vos images, ces fichiers seront plus petits et donc, par exemple, pourront étre
envoyés plus facilement par courriel. Vous pourrez alors exporter le pdf sans compression pour
avoir un maximum de qualité, sans avoir un fichier trop gros. De plus, ces logiciels étant dédiés au
traitement d’images, il est souvent plus facile de redimensionner correctement celles-ci.

W



3 Les numéros de page
Vous pouvez numéroter vos pages en :
* Insérant un pied de page
* Y insérant un numéro de page

Pour insérer le pied de page, cliquez simplement en base de la page. Une boite comme ci-dessous
apparait. Cliquez dessus pour ajouter le pied de page.

Pied de page (Premiére page] <4
NB : cela fonctionne aussi pour les entétes.
Pour ajouter le numéro, allez dans la barre d’outils, puis dans Champs > Numéro de page.

Pour que vos pages aient des numéros de la forme : numéro de la page/nombre de page, ajoutez le
caractere '/' apres le numéro de la page puis insérez le champ Nombre de pages.

4 Rupture de page

Si vous désirez qu’un texte commence toujours sur une nouvelle page, par exemple le texte qui suit
la page de garde ou le sommaire, il faut insérer un saut de page avant ce texte. Allez dans Insertion
> Saut manuel... Vous pouvez également insérer des sauts de paragraphes et de colonnes.

Insérer un saut

Type
oK
Renvoi a la ligne
Saut de colonne Annuler
@ Saut de page
Aide
Style
[Aucun] v

Modifier le numéro de page

Si vous voulez que vos titres commencent impérativement sur une nouvelle page, allez dans le
panneau de style, puis dans 1’onglet Enchainement de votre titre. Cochez la case Insérer et laissez
les autres champs aux valeurs par défaut.



Style de paragraphe: Titre 1

Plan & numérotation Tabulations Lettrines Arriére-plan Bordures

f !
Gérer | Retraits et espacement = Alignement | Enchainements = Police | Effets de caractéres Position

Coupure des mots

Automatiquement
2 Caractéres en fin de ligne
2 Caractéres en debut de ligne

0 MNombre maximum de coupures consécutives

Type Page v Paosition |Devant v

Avec le style de page Muméro de page |0
Options

Me pas scinder le paragraphe

¥ Conserver avec le paragraphe suivant

Traitement des orphelines 2 Lignes
Traitement des veuves 2 Lignes
oK Appliguer Annuler Aide Réinitialiser Standard

5 Faire une page de garde

Pour faire une vraie page de garde, avec du texte centré sur la page, des entétes et pieds de page
spécifiques, c’est assez simple. Placez-vous sur la page a convertir. Allez dans Format > Page de
titre... Sélectionnez Convertir les pages existantes en page de titre.

i



Pages de titre

Créer des pages de titre

@ Convertir des pages existantes en pages de titre!

Insérer des nouvelles pages de titre

Mombre de pages de titre 1 ! pages

W

Placer la page de titre 3 © Début du document

Page 6

Mumérotation des pages
Réinitialiser la numérotation aprés les pages de titre
Numéro de page 1
Définir Le numéro de page pour la premiére page de titre
Numéro de page 1

Editer les propriétés de la page

Premiére page . Editer...

Ok Annuler Aide

Vous pouvez choisir si la page doit étre numérotée et a quel chiffre la numérotation doit reprendre
apres cette page.

Pour mettre un texte (le titre de votre document par exemple) bien au centre de la page, allez dans
Insérer > Cadre... Sélectionnez la largeur comme relative et a 100 %. Dans la section position,
choisissez Centré pour les alignements verticaux et horizontaux. Dans 1’onglet Bordures, vous
pouvez supprimer la bordure. Ceci est aussi valable pour les autres pages.



Cadre

Type Options Adaptation du texte Hyperlien Bordures Arriére-plan| Colonnes Macro

Taille Ancrer
Largeur 100% - © Alapage
+ Relatif 7 Au paragraphe
" Automatigue 7 Au caractére
. ~ . O
Hauteur (minimum) 0.50cm |, Comme caractére
! Relatif
¢ Taille automatique

Conserver le ratio

Paosition

Horizontal Centre R 3 0,00cm pour |Page entiére -
| En vis-a-vis sur les pages paires
Wertical Centre hd 3 0,00cm : pour Zone de texte de page ¥

Respecter les enchainements

oK Annuler Aide Réinitialiser

6 Le sommaire automatique

Maintenant que vous savez faire des titres, vous aimeriez bien les intégrer dans votre sommaire. Eh
bien LibreOffice va le faire pour vous. Dans la barre d’outils, allez dans Insertion > Index et tables

> Index et tables...

~J



Insertion d'index

f |
Index |Entrées|Styles Colonnes| Arrigre-plan

Type et titre
Somimaire Titre m
Timre 1 1
Tire 1.1 |
B ! L Type Table des matiéres v
Tiwe 1 ¥ Protégé contre toute modification manuelle

Waicile teste du premier chapine. Is'agit dune entrée dindex personnalisé.

Créer un index

texte du chapitre 1.1, T s'agit dune extrée pour I table des matires. = .

pour Document entier ~ | Evaluer jusqu'au niveau 10
2
Wi le terte du chapitre 1.2 Ce mot-clé estune enrée principals

Créer a partir de

[ I I I T } ¥ Plan

Styles supplémentaires

¥ Marques d'index

oK Annuler Aide Réinitialiser ¥ Aperqu

Validez avec OK. Vous avez un sommaire automatique ! Libre a vous de parcourir toutes les options
proposées. Par défaut, cette table s’appelle Table des matiéres. Vous pouvez la renommer en
modifiant son champ Titre comme ci-dessus. Je vous conseille fortement de laisser cochée la case
Protégé contre toutes modifications manuelles. Pensez également a faire un clic droit puis
Actualiser I’index/la table de facon a ce que LibreOffice prenne en compte les modifications que
vous avez apportées aux titres (ajouts, suppressions, déplacements a une page différente...). Vous
pouvez également aller dans Outils > Actualiser > Tout actualiser.

Pour modifier 1’apparence du contenu de la table des matieres, faites un clic droit sur une entrée
puis sélectionnez éditer le style de paragraphe. Vous pouvez également passer par 1’écran de style
en sélectionnant une des entrées Table des matiéres. Vous avez 10 niveaux de numérotation a votre
disposition.

Sommaire ou table des matiéres ? Le sommaire est plus synthétique (3-4 niveau de titre
maximum) que la table des matiéres et est placé en début de document.

7 La correction orthographique et grammaticale

7.1 La correction orthographique

Dans I’écran de style, vous pouvez également sélectionner une langue pour chaque entrée. Comme
vous pouvez ajouter des entrées, vous pouvez créer un corps de texte en francais et un autre en
anglais, ce qui vous simplifiera la vie.



Style de paragraphe: Corps de texte

Plan & numérotation Tabulations Lettrines Arrigre-plan Bordures Condition 2] [ o & Tz -
Gérer | Retraits et espacement = Alignement | Enchainements | Police | Effets de caractéres | Position | | alinéa négatif

Bibliographie 1
Famille Style Taille Citation

Contenu de liste

Liberation Serif MNormal 12pt Contenu de tableau
1opt Contenu du cadre
LKLUG Gras 10,5pt
Lohit Assamese Italique 1lpt Dessin
Lohit Bengali Italique gras Destinataire
Lohit Devanagari 13pt En-téte
Lohit Gujarati 14pt En-téte de liste
Lohit Kannada 15pt En-téte droit
En-téte gauche
Langue Expéditeur
- FormuLe.finaLe
emraen
Index

& Francais (Luxembourg) Index d'objet 1

La méme police est utilisée pour l'impression et l'af.%, Francais (Monaco) | I )
B ndex des illustrations 1

_%’ Frangais (Suisse) Index des tables 1

Frioutien Index lexical 1

Liberatis Frls{o.n ) Index lexical 2

Gaelique (Ecosse) N Index Lexical 3

Galicien
Tous les styles v
L
OK Appliquer Annuler Aide Réinitialiser Standard

Pour des modifications de langues plus ponctuelles, faites un clic gauche sur la langue dans la barre
du bas et sélectionnez plus. Dans 1’onglet police, sélectionnez la langue que vous désirez. Vous
pouvez également choisir aucune pour n’avoir aucune correction (car vous étes vraiment bon en
orthographe, ce paragraphe contient du code...)

Si vous voyez la langue avec un trait bleu a coté, cela veut dire quelle est installée, sinon c’est a
vous de I’ajouter. Sous Linux, consultez votre gestionnaire de paquets, sous Windows, allez voir

http://extensions.libreoffice.org/extension-center/dictionnaires-francais.

7.2 La correction grammaticale

LibreOffice ne propose pas de correcteur grammatical par défaut. Heureusement, la communauté
propose des extensions pour pallier ce probléeme. Vous pouvez installer LanguageTools qui supporte
de nombreuses langues et grammalecte qui ne supporte que le francais mais renvoie moins de faux
positifs.

http://www.languagetool.org/
http://www.dicollecte.org/grammalecte/

8 Divers

8.1 Puces et numérotation

Pour construire une liste, allez dans le menu Format > Puces et numérotation. De nombreux
formats de puces et de numérotation sont disponibles. Et méme des plans ! Faites votre choix.

8.2 Les divers collages

Lorsque vous collez un texte, par défaut, LibreOffice conserve le formatage. Néanmoins, parfois


http://www.dicollecte.org/grammalecte/
http://www.languagetool.org/
http://extensions.libreoffice.org/extension-center/dictionnaires-francais

vous désirez vous en débarrasser. Pour cela, utilisez le raccourcis clavier Ctrl + Maj + V et
sélectionnez texte non formaté. Les autres options de texte garde une partie du formatage.

9 Citations

« Note that underlining for emphasis is considered bad practice in the publishing world.
Underlining is only used when the output device can’t do highlighting in another way — for
example, when using a typewriter. »

Michel Goossens et al. in the LATEX Companion

« Perhaps poets who wish to speak in astill small voice Will cause future books to make use of frequent
font variations, but nowadays it’s only an occasional font freak (iike the author of this manual) who likes such
experiments. »

Donald Knuth in the TEXbook

10 Auteur et licences

Ce document a été écrit par Julien ENSELME, éléve a 1’école Centrale Marseille pour 1’'usage de tous
ceux qui veulent. Vous pouvez envoyer vos suggestions a jenselme@centrale-marseille.fr et trouver
une version actualisée de ce document (et peut-étre des tutos sur les autres logiciels de la suite
bureautique LibreOffice) :

e en odt : http://www.jujens.eu/static/libreoffice/tuto LibreOffice Writer basique.odt

* en pdf : http://www.jujens.eu/static/libreoffice/tuto LibreOffice Writer basique.pdf

* en ligne : http://www.jujens.eu/posts/2013/Dec/02/tuto _LibreOffice Writer basique/

Ce document est distribué sous Creative Commons BY-SA v3 (Parité, partage a I’identique). Pour
plus d’information, voir :

https://creativecommons.org/licenses/by-sa/3.0/legalcode
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